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Introduction

Thank you for purchasing your MPC. At Akai Professional, we know how serious music is to you. That’s why we
design our equipment with only one thing in mind—to make your performance the best it can be.

This user guide explains how to create music using MPC X, MPC Live, MPC Live I, MPC One, MPC Studio Il and
MPC Touch. There is similar documentation available for MPC products that use an LCD and for the MPC software
application. To view these user guides, click the Help menu in the MPC software, select MPC Help, and select an
option.

Welcome to the MPC family.

Akai Professional

System Requirements & Product Support

For the latest information about this product (system requirements, compatibility information, etc.) and product
registration, visit akaipro.com.

For additional support, visit akaipro.com/support.

About This User Guide

This manual should help you get familiar with using your MPC X, MPC Live, MPC Live Il, MPC One, MPC Studio Il
or MPC Touch (from here on, “MPC hardware” unless otherwise noted). For consistency, the terminology throughout
is based on the MPC nomenclature. We also used specific formatting to indicate particular topics of significance:

Important/Note/Tip: Important or helpful information on a given topic.

Names of buttons, controls, parameters, settings, and other options are written in bold characters throughout the manual.
Examples: Press the Play Start button.
Turn Q-Link Knob 4.
Tap the Mute button.
The Velocity ranges from 0 to 127.
Set the Sample Play selector to One Shot.

Tap BPM, and then use the numeric keypad to enter 120 as the tempo.

Some parts of this manual refer to other relevant chapters or sections, which are cited in bold, italic blue characters.
Click the text to skip immediately to that section.

Examples: Read the Important Notes section before proceeding.
For more information about installing the necessary drivers and software, see Setup > 2. Installation.

To learn more about using send effects, see General Features > Effects > Send/Return Effects.

(o]
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Important Notes

Read the included safety & warranty manual before using your MPC hardware.

Before getting started and connecting devices to your MPC hardware or turning the hardware on/off, make sure all
devices are switched off.

To use your MPC hardware in Controller Mode (to control the MPC software):

Before installing the MPC software, make sure your computer meets the system requirements described at
akaipro.com. This applies whether you’ll use MPC software as your host software or as a plugin in another digital
audio workstation (DAW).

Before connecting your MPC hardware to your computer, install the drivers and software. Visit akaipro.com to
download the latest versions. Refer to the 2. Installation section for more information.

1. Connection

Here is just an example of how to use MPC X in your setup. ltems not listed under Introduction > Box Contents of
your included Quickstart Guide are sold separately.

Headphones Footswitch
(to front-panel headphone output) (to front-panel FS1 input) Powered Monitors Computer

SD Card
(to front-panel SD card slot)

\WKAI MPEX

PIfl FESSIONAL TUSCPRODUGTION GENTER

GATE

7 _6
N A A

(7N LANN (7Y

MIDI OUT

Power

Microphone Turntable
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Remember to remove the protective film from your MPC hardware touchscreen!

To use your MPC hardware in Standalone Mode, just connect it to a power outlet using the included power
adapter, and power it on!

Note: We highly recommend checking akaipro.com for any available updates to the MPC software/firmware and/or
drivers.

To use your MPC hardware in Controller Mode, continue to Step 2. Installation.

2. Installation

To use your MPC hardware in Controller Mode (to control the MPC software), follow these steps to download
and install the required drivers & software:

@

P 0D~

Go to akaipro.com and register your product. If you don’t have an Akai Professional account yet, you will be
prompted to create one.

In your Akai Professional account, download the MPC software package.
Open the file and double-click the installer application.
Follow the on-screen instructions to complete the installation.

Note: By default, the MPC software will be installed in [your hard drive]\Program Files\Akai Pro\MPC (Windows®)
or Applications (macOS®). You can also create a shortcut on your Desktop.

. Getting Started

Power on your MPC hardware.

On your computer, open the MPC software.

Follow the on-screen instructions to authorize your version of MPC.

You will need an iLok account to complete this. You can create an account at ilok.com.

Make a note of the PACE code in your account, and enter it when asked for it during the authorization/unlock
process.

On your MPC hardware, check the upper-right corner of the touchscreen:

e If there is a monitor/cable icon, then your MPC hardware is already in Controller Mode.
Continue to Step 6.

e If there is a chip icon, then your MPC hardware is in Standalone Mode. Follow these steps:
i. Press Menu to enter the Menu.

ii. Tap the MPC chip icon in the upper-right corner. IEI

iii. In the Enter Controller Mode window that appears, tap Controller Mode. Looking
for computer may appear briefly on the screen before your MPC hardware recognizes
the USB connection as a controller.

In the MPC software, click the Edit menu, and select Preferences. Click the Audio tab and select the sound
card you want to use. Click OK when you are done.

Important:

We highly recommend using your MPC hardware’s sound card (Akai Pro MPC X/Live/Live 1I/One/Touch ASIO).
If you need to use the internal sound card on a Windows computer, we recommend downloading the latest
ASIO4ALL driver at asio4all.com.

To view the MPC software user guide, click the Help menu in the MPC software, select MPC Help, and select
MPC User Manual.

10
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This chapter explains the features and functions of each MPC model with a touchscreen: MPC X, MPC Live, MPC

Live Ill, MPC One and MPC Touch.

Note: If you are using the MPC Studio Il, the display does not function as a touchscreen but can be used in conjunction
with the software to select tracks, programs, and files, as well as edit samples or change project parameters.

Touchscreens

Here is some general information about how to use the touchscreen on your MPC:

Tap a button or option to select it. Use the data dial or
—/+ buttons to change its setting or value

S

R

Spread two fingers to zoom in (into a section of a
waveform, for example). Pinch two fingers to zoom out.

Double-tap a button to access advanced editing options.
In some cases, this will show a numeric keypad that you
can use to enter a value (an alternative to the data dial
or —/+ buttons). Tap the upper-left part of the screen to
return to the previous view.

The top of the screen shows the toolbar, which contains
information about the current view (often the name of
the current track, sequence, audio pointer position,
etc.). Tap an item to select it.

The bottom of the screen shows various buttons that
you can use in the current view. Tap a button to press it.

To return to a previous view, either tap outside of the
window currently on the screen or tap the left arrow (€)
in the upper-left part of the screen.

11
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Navigation & Data Entry Controls

1. Touchscreen: This full-color multi-touch display shows information relevant to MPC X’s current operation.
Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the previous
Touchscreens section to learn how to use some basic functions.

Tip: If you adjust the angle of the touchscreen, use the stand on its back panel to secure it in place.

2. Cursors: Press these buttons to navigate through the fields of menus and options shown on the screen. Press
and hold Shift and press these buttons to zoom in or out of the Grid View or Audio Edit Mode. Press and hold
Shift and press the up and down cursors simultaneously or the left and right cursors simultaneously to return
to the default zoom setting.
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Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field on the screen.

—-/+: Press these buttons to increase or decrease the value of the selected field on the screen.

Numeric Keypad: If the selected field on the screen is a number, press these numbered buttons as you would
on a standard numeric keypad to enter a value. Press the keypad’s Enter to enter it. (A numeric keypad with
additional operations will appear on the screen, as well.)

Undo/Redo: Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

Shift: Press and hold this button to access some buttons’ secondary functions (indicated by red writing).
Double-press this button to see which buttons have secondary functions —the buttons will flash for a few seconds.

F-Key: Press this button to activate or deactivate the F-Key feature. When active, the six buttons under the
touchscreen correspond to the options shown at the bottom edge of the screen. The F-Key button and those six
buttons will be lit red when active. When inactive, the six buttons under the touchscreen will access their normal
modes instead (Menu, Browser, Step Seq, Sampler, XYFX, and Looper).

Pad & Q-Link Controls

10.

11.

12.

13.

14.

Q-Link Knobs: Turn these touch-sensitive knobs to adjust various parameters and settings. The display strip
above each knob indicates the parameter it is controlling. If the display strip shows a meter to indicate its value,
you can touch or turn its Q-Link knob to temporarily show its precise numerical value.

Pads: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive
and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different
colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest
velocity). You can also customize their colors.

Pad Bank: Press these buttons to access Pad Banks A-D.

Press and hold Shift while pressing these buttons to access Pad Banks E-H. Alternatively, double-press one of
these buttons.

Copy/Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the
“destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap
Do It to continue or Close to return to the previous screen.

Tip: To quickly copy a pad, press and hold Copy, press the source pad, press the destination pad, and then
release Copy.

Press and hold Shift and press this button to delete a pad’s sample assignment. When the Delete Pad window
is shown, press any pad/pads whose sample assignments you want to clear. Tap Delete to continue or Cancel
to return to the previous screen.

Full Level/Half Level: Press this button to activate or deactivate the Full Level feature. When activated, the pads
will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

Press and hold Shift and then press this button to activate or deactivate the Half Level feature. When activated,
the pads will always trigger their samples at half-velocity (64).

16 Level / Pad Perform: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit
will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a
selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum,
Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the Type selector
to choose the parameter: Velocity, Tune, Filter, Layer, Attack or Decay. See Operation > General Features > 16
Level to learn more.

Press and hold Shift and press this button to enter Pad Perform mode for the pads. When activated, you can
play musical scales/modes, chords or progressions using the pads while in any mode. See Operation > Modes
> Pad Perform Mode to learn more.

13



15.

16.

17.

18.

19.

20.

Note Repeat/Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.

Project: Press this button to use the Q-Link knobs to adjust parameters related to the current project. Press and
hold Shift and then press this button to enter the Project Q-Link Edit Mode directly. See Operation > Modes >
Q-Link Edit Mode > Project to learn about this.

Program: Press this button to use the Q-Link knobs to adjust parameters of the currently selected program or
audio track. Press and hold Shift and then press this button to enter the Program Q-Link Edit Mode directly. See
Operation > Modes > Q-Link Edit Mode > Program to learn about this.

Pad Scene: Press this button to use the Q-Link knobs to adjust parameters that you have assigned for the
currently selected pad. Press and hold Shift and then press this button to enter the Pad Scene Q-Link Edit Mode
directly. See Operation > Modes > Q-Link Edit Mode > Pad Scene to learn about this.

Pad Param: Press this button to use the Q-Link knobs to adjust one parameter across all 16 pads. Each Q-Link
knob corresponds to the pad with the same number and position in the 4-by-4 layout. Press and hold Shift and
then press this button to enter the Pad Param Q-Link Edit Mode directly. See Operation > Modes > Q-Link Edit
Mode > Pad Parameter to learn about this.

Screen Control/Edit: Press this button to use the Q-Link knobs to adjust parameters in the currently selected
mode as shown on the screen. See Operation > Modes > Q-Link Edit Mode > Screen to learn about this.

Press and hold Shift and then press this button to enter Q-Link Edit Mode where you can assign other parameters
to the Q-Link knobs.

Mode & View Controls

Note: See Operation > Modes to learn about the different modes you can access with these controls.

21.
22.

23.

24,

25.

26.

27.

28.
29.

Menu: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.
Main/Track: Press this button to enter Main Mode.
Press and hold Shift and then press this button to enter the Track View.

Browse/Save: Press this button to view the Browser. The Browser lets you navigate your computer’s internal
and external hard disks to load samples, sequences, songs, etc. Using filter buttons and user-definable folders,
you can easily adapt it to your workflow. You can also preview samples before loading them.

Press and hold Shift and press this button to save the current project (including its samples, programs, sequences,
and songs).

Step Seq/List Edit: Press this button to view the Step Sequencer where you can create or edit sequences by
using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

Press and hold Shift and press this button to view your sequences using the List Edit View instead of the Grid View.

Sampler/Looper: Press this button to view the Sampler where you can record audio samples to use in your
projects.

Press and hold Shift and press this button to view the Looper where you can record and overdub audio in real
time—a great tool for live performance as well as spontaneous moments in the studio. You can export the loop
as a sample to use in your project.

XYFX: Press this button to view XYFX Mode, which turns the touchscreen into an XY pad where each axis
represents the range of an effect parameter. As you move touch or move your finger on the screen, the current
position will determine the current value of the two parameters. You can use this mode to create interesting
effect automation on your tracks.

Pad Perform: Press this button to view Pad Perform Mode where you can assign musical scales/modes, chords,
or progressions to the pads for creative performance options.

Prog Edit: Press this button to view Program Edit Mode, which contains all parameters for editing your programs.

Sample Edit: Press this button to view Sample Edit Mode where you can edit your samples using various
functions and processes.
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30.

31.

32.

33.

Pad Mixer: Press this button to view the Pad Mixer where you can set a program’s levels, stereo panning,
routing, and effects.

Ch. Mixer: Press this button to view the Channel Mixer where you can set levels, stereo panning, and other
settings for your tracks, programs, returns, submixes and masters.

Track Mute/Pad Mute: Press this button to view Track Mute Mode where you can easily mute tracks within a
sequence or set mute groups for each track.

Press and hold Shift and press this button to view Pad Mute Mode where you can easily mute pads within a
program or set mute groups for each pad within a program.

Next Seq/Song: Press this button to view Next Sequence Mode where you can trigger different sequences simply
by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.

Press and hold Shift and press this button to view Song Mode where you can arrange sequences in a specific
order and/or repetition to create songs. You can edit the structure of a song during playback for easy, on-the-fly
composing.

Transport & Recording Controls

34.
35.
36.

37.

38.

39.

40.

41.

42.

43.

Play: Press this button to play the sequence from the audio pointer’s current position.
Play Start: Press this button to play the sequence from its start point.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all
voices and stop all audio processing.

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

</> (Event |</>|): Use these buttons to move the audio pointer left or right, one step at a time.

Press and hold Locate and press one of these buttons to move the audio pointer to the previous/next event in
the sequence grid.

<</>> (Start/End): Use these buttons to move the audio pointer left or right, one bar at a time.

Press and hold Locate and press one of these buttons to move the audio pointer to the start or end of the
sequence grid.

Locate: Press and hold this button to activate the secondary functions of the </> and <</>> buttons (i.e., Event
|</>| and Start/End, respectively).

Erase: As a sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. See Operation > General Features > Erase to learn more.

Tap/Master: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how
many taps are required in the Preferences (see Operation > General Features > Menu > Preferences to learn
how to do this).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit red) or a master tempo (the button will be lit amber).
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I/0 & Level Controls

44.

45.

46.

47.

48.
49.

50.

51.

52.

583.

54.

55.

Gain 1/2: Use these knobs to adjust the gain of the incoming signal from Input 1/2 on the rear panel or Inst 1/2 on
the front panel. Use the Rear/Front switches below the knobs to determine the input. Use the level meter to
check the recording level. Be careful when setting this knob at higher levels, which can cause the signal to distort.

Rear/Front: Use each switch to set whether the Gain 1/2 knob above it will control the gain of the input signal on
the rear panel (Input 1/2) or on the front panel (Inst 1/2).

Phantom Power (+48V): This switch activates and deactivates phantom power for Input 1/2. When activated,
+48V of phantom power will be supplied to both inputs. Note that most dynamic microphones do not require
phantom power, while most condenser microphones do. Refer to your microphone’s documentation to check if it
needs phantom power.

3/4 Rec Gain: Use this knob to adjust the gain of the incoming signal from Input 3/4 on the rear panel. Use the
level meter to check the recording level. Be careful when setting this knob at higher levels, which can cause the
signal to distort.

Master: Turn this knob to adjust the volume level of the Main L/R outputs.
Direct/Main: Turn this knob to adjust the balance between the input and output signals in the headphones.

Direct corresponds to the input signal—all devices connected to the inputs on the front and rear panels.
While recording, you can turn this knob all the way to Direct for zero-latency direct monitoring.

Main corresponds to the output signal—the signal sent from the Main L/R outputs on the rear panel. When
you are not recording, we recommend turning this knob all the way to the Main position to hear the full-
volume playback signal.

Stereo/Mono: Use this switch to set whether the signal in the headphones is binaural (Stereo) or monaural
(Mono). When set to Stereo, the headphone signal will be split so that the input signal (Direct) is heard in the left
ear while the output signal (Main) is heard in the right ear. When set to Mono, the input and output signals are
blended into a single, summed mix, which is heard in both ears.

Rec Arm: Press this button to arm or disarm recording for the currently selected audio track, shown in the
display strip below the level meters (see Operation > General Features > Menu > Preferences to learn how to
set what is shown in the level meters).

Read/Write: Press this button to toggle the automation state for the program on the current track or for the
current audio track betwen Read (green R) and Write (red W). The display strip below the level meters must show
a program or audio track (see Operation > General Features > Menu > Preferences to learn how to set what is
shown in the level meters).

Press and hold Shift and press this button to turn off global automation.

Mute: Press this button to mute the program, audio track, or master output shown in the display strip below the
level meters (see Operation > General Features > Menu > Preferences to learn how to set what is shown in
the level meters).

Solo: Press this button to solo the currently selected program or audio track shown in the display strip below the
level meters (see Operation > General Features > Menu > Preferences to learn how to set what is shown in the
level meters).

Level Meters: These meters indicate the level of the audio signal shown in the display strip below them. See
Operation > General Features > Menu > Preferences to learn how to set what is shown in the level meters.
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1. SD Card Slot: Insert a standard SD/SDHC card into this slot to access its files directly using MPC X.

Footswitch Inputs (FS 1/2) (1/4” / 6.35 mm): Connect optional 1/4” (6.35 mm) TS footswitches to these inputs.

3. Instrument Inputs (Inst 1/2) (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TS cables to connect these inputs to
audio sources (guitars, bass, etc.). To use each of these inputs, set the corresponding Rear/Front switch (below
the Gain 1/2 knob on the top panel) to Front.

4. Mix Knob: Turn this knob to adjust the balance between the Main and 3/4 signals in your headphones. Main is
the signal sent from the Main L/R outputs. 3/4 is the signal sent from the Outputs 3/4.

5. Headphone Outputs (1/8” or 1/4” / 3.5 mm or 6.35 mm): Connect your headphones (not included) to either or
both of these standard stereo outputs. Use the Mix Knob to determine what signal is heard in the headphones.
Turn the Headphone Volume knob to set the volume level.

6. Headphone Volume: Turn this knob to adjust the volume of the headphone outputs.
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Rear Panel

10.

11

12.

13.

14.

KAI MPCX
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Power Input: Use the included power adapter to connect MPC X to a power outlet. This must be connected to a
power outlet in order for MPC X to power on.

Power Adapter Restraint: Secure the power adapter cable to this restraint to prevent it from accidentally unplugging.

Power Switch: Press this button to turn MPC X’s power on or off. While powered on, press and hold this button
for 5 seconds to force MPC X to power off (similar to a computer).

USB-B Port: Use the included USB cable to connect this USB 3.0 port to an available USB 3.0 port on your
computer. This connection allows MPC X to send/receive MIDI and audio data to/from the MPC software on your
computer. It also allows any connected USB drives, SD cards, and drives connected to the internal SATA port to
mount on your computer if MPC X is in Controller Mode (i.e., your computer can access these storage devices
that are connected to your MPC X).

USB-A Ports: Connect USB flash drives to these USB ports to access their files directly using MPC X. MPC X
supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well as read-only capability
for HFS+ file systems. (We recommend using an exFAT file system as it is the most robust one supported by
both Windows and macOS.) These USB ports supply power to connected USB devices and can also be used to
receive MIDI messages from external USB MIDI devices.

Inputs 1/2 (XLR or 1/4” / 6.35 mm): Use standard XLR or 1/4” (6.35 mm) TRS cables to connect these inputs to
audio sources (microphone, mixer, synthesizer, etc.). To use each of these inputs, set the corresponding
Rear/Front switch (below the Gain 1/2 knob on the top panel) to Rear. Turn the Gain 1/2 knobs to set the input
level of each one.

Note: When using the XLR connection, the mic pre-amp is automatically engaged. When using a 1/4" (6.35 mm)
TRS cable, the mic pre-amp is bypassed.

Inputs 3/4 (1/4” / 6.35 mm or RCA): Use standard 1/4” (6.35 mm) TRS cables or stereo RCA cables to connect
these inputs to audio sources (mixer, turntable, synthesizer, etc.). To use the 1/4” (6.35 mm) inputs, set the
Phono/Line switch to Line. To use the RCA inputs, set the Phono/Line switch to Phono. Turn the 3/4 Rec Gain
knob to set their input levels.

Phono/Line Switch: Set this switch to the appropriate position, depending on which Input 3/4 connectors you
want to use. If you are using the 1/4” (6.35 mm) inputs, set this switch to Line. If you are using the RCA inputs,
set this switch to Phono to provide the additional amplification needed for phono-level signals.

Grounding Terminal: If you are sending a phono-level turntable signal to the Input 3/4 RCA connectors and are
hearing a low hum or buzz, it could mean that the turntable is not grounded. If the turntable has a grounding
wire, connect it to this terminal.

Note: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be
connected to the grounding terminal.

Main L/R Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your
speaker system. The signal sent out of these outputs is the master mix. Turn the Master knob to set their volume.
Tip: To route a program to these outputs, set its routing to Out 1,2 in the Channel Mixer when the Mixer field is
set to Programs. See Operation > Modes > Channel Mixer to learn more about this.

. Outputs 3/4, 5/6, 7/8 (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to an

external mixer. The signal sent from these outputs is full-volume (0 dB).

Tip: To route a program to these outputs, set its routing to Out 1,2, Out 5,6, or Out 7,8 (respectively) in the
Channel Mixer when the Mixer field is set to Programs. See Operation > Modes > Channel Mixer to learn
more about this.

MIDI In: Use standard 5-pin MIDI cables to connect these inputs to the MIDI outputs of optional external MIDI
devices.

MIDI Out: Use standard 5-pin MIDI cables to connect these outputs to the MIDI inputs of optional external MIDI
devices.

CV/Gate Out: Use standard 1/8” (3.5 mm) TS cables to connect these outputs to optional external sequencers.
MPC X will send control voltage (CV) and/or Gate data over this connection.
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1. Touchscreen: This full-color multi-touch display shows information relevant to MPC Live’s current operation.
Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the previous
Touchscreens section to learn how to use some basic functions.

2. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field on the screen. Pressing the dial also functions as an Enter button.

3. Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can control
one group of parameters at a time. The lights below the Q-Link button indicate the currently selected column of Q-
Link knobs. Press the Q-Link button to change which parameter or group of parameters they currently control.

4. Q-Link Button: Press this button to change which parameter or group of parameters the Q-Link knobs currently
control (indicated by the lights above the Q-Link knobs). Each press will select the next column of Q-Link knobs.

Press and hold Shift and then press this button to select the previous column of Q-Link knobs instead.

Press and hold this button to show the QLink window over the touchscreen’s current contents. These are the same
parameters and settings as what is shown in Q-Link Edit Mode. You can tap Q-Link Edit at the bottom of the
window to enter Q-Link Edit Mode immediately (see Operation > Modes > Q-Link Edit Mode to learn about this).

5. Pads: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive
and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different
colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest
velocity). You can also customize their colors.

6. Pad Bank: Press any of these buttons to access Pad Banks A-D.

Press and hold Shift while pressing any of these buttons to access Pad Banks E-H. Alternatively, double-press
one of these buttons.

7. Note Repeat/Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.
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10.

11.

12.

13.

14.

15.

16.
17.
18.
19.

20.

21.

22.

Full Level/Half Level: Press this button to activate or deactivate the Full Level feature. When activated, the pads
will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

Press and hold Shift and then press this button to activate or deactivate the Half Level feature. When activated,
the pads will always trigger their samples at half-velocity (64).

16 Level / Pad Perform: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit
will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a
selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum,
Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the Type selector
to choose the parameter: Velocity, Tune, Filter, Layer, Attack or Decay. See Operation > General Features > 16
Level to learn more.

Press and hold Shift and press this button to enter Pad Perform mode for the pads. When activated, you can
play musical scales/modes, chords or progressions using the pads while in any mode. See Operation > Modes
> Pad Perform Mode to learn more.

Erase: As a sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. See Operation > General Features > Erase to learn more.

Shift: Press and hold this button to access some buttons’ secondary functions (indicated by gray writing).
Double-press this button to see which buttons have secondary functions—the buttons will flash for a few seconds.
Menu/Browse: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.

Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate and
select programs, samples, sequences, etc.

Main/Track: Press this button to enter Main Mode.

Press and hold Shift and then press this button to enter the Track View.
Undo/Redo: Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

Copy/Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the
“destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap
Do It to continue or Close to return to the previous screen.

Tip: To quickly copy a pad, press and hold Copy, press the source pad, press the destination pad, and then
release Copy.

Press and hold Shift and press this button to delete a pad’s sample assignment. When the Delete Pad window
is shown, press any pad/pads whose sample assignments you want to clear. Tap Delete to continue or Cancel
to return to the previous screen.

-/+: Press these buttons to increase or decrease the value of the selected field on the screen.
Play: Press this button to play the sequence from the audio pointer’s current position.
Play Start: Press this button to play the sequence from its start point.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all
voices and stop all audio processing.

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

Tap/Master: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how
many taps are required in the Preferences (see Operation > General Features > Menu > Preferences to learn
how to do this).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit red) or a master tempo (the button will be lit amber).

20



Rear Panel

)

MIDI out

. .
@m A % O o= A gmf’a \\\\\\\\\\\\\\\\\\\\\\\\Q@

ND A
8}5 EECe: 00 v g g®@

1. Power Input: Use the included power adapter to connect MPC Live to a power outlet.

Power Switch: Turns MPC Live’s power on/off.

Charging Indicator: This light (behind the vent) will turn on when MPC Live’s internal battery is charging (when
the power input is connected to a power outlet). When the battery is fully charged or when it is disconnected
from a power outlet, then this light will turn off.

4. USB-B Port: Use the included USB cable to connect this USB 3.0 port to an available USB 3.0 port on your
computer. This connection allows MPC Live to send/receive MIDI and audio data to/from the MPC software on
your computer. It also allows any connected USB drives, SD cards, and drives connected to the internal SATA
port to mount on your computer if MPC Live is in Controller Mode (i.e., your computer can access these storage
devices that are connected to your MPC Live).

5. USB-A Ports: Connect USB flash drives to these USB ports to access their files directly using MPC Live. MPC
Live supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well as read-only
capability for HFS+ file systems. (We recommend using an exFAT file system as it is the most robust one
supported by both Windows and macQOS.) These USB ports supply power to connected USB devices and can
also be used to receive MIDI messages from external USB MIDI devices.

6. SD Card Slot: Insert a standard SD/SDHC card into this slot to access its files directly using MPC Live.

Rec Vol: Turn this knob to adjust the gain of the incoming signal from the 1/4” (6.35 mm) and RCA inputs. Be
careful when setting this knob at higher levels, which can cause the signal to distort.

Master Vol: Turn this knob to adjust the volume of Output 1/2 and the phones output.

Inputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to audio sources
(microphone, mixer, synthesizer, etc.). To use these inputs, set the Line/Phono switch to Line. Turn the Rec Vol
knob to set their input levels.

10. Inputs (RCA): Use a standard RCA stereo cable to connect these inputs to a phono-level audio source like a
turntable. To use these inputs, set the Line/Phono switch to Phono. Turn the Rec Vol knob to set their input levels.

11. Line/Phono Switch: Set this switch to the appropriate position, depending on which inputs you want to use. If
you are using the RCA inputs, set this switch to Phono to provide the additional amplification needed for phono-
level signals. If you are using the 1/4” (6.35 mm) inputs, such as a keyboard or a sampler, set this switch to Line.

12. Grounding Terminal: If using phono-level turntables with a grounding wire, connect the grounding wire to these
terminals. If you experience a low “hum” or “buzz”, this could mean that your turntables are not grounded.
Note: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be
connected to the grounding terminal.

13. Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your speaker
system, external mixer, etc. The signal sent out of the Master L/R outputs is the master mix. Turn the Master
Vol knob to set their volume. The signals sent from Outputs 3-6 are full-volume (0 dB).

Tip: To route a program to these outputs, set its routing to Out 1,2, Out 3,4, or Out 5,6 (respectively) in the
Channel Mixer when the Mixer field is set to Programs. See Operation > Modes > Channel Mixer to learn
more about this.

14. Phones (1/8” / 3.5 mm): Connect standard 1/8” (3.5 mm) stereo headphones to this output. Turn the Master Vol
knob to set the volume level.

15. MIDI In: Use standard 5-pin MIDI cables to connect these inputs to the MIDI outputs of optional external MIDI
devices.

16. MIDI Out: Use standard 5-pin MIDI cables to connect these outputs to the MIDI inputs of optional external MIDI
devices.

17. Kensington® Lock Slot: You can use this slot to secure your MPC Live to a table or other surface.
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1. Touchscreen: This full-color multi-touch display shows information relevant to MPC Live II’s current operation.
Touch the display (and use the hardware controls) to control the MPC interface. See the previous Touchscreens
section to learn how to use some basic functions.

2. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field in the display. Pressing the dial also functions as an Enter button.

3. Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can
control one column of parameters at a time. The lights above the Q-Link Knobs indicate the currently selected
column. Press the Q-Link button above them to change which column of parameters they currently control.

4. Q-Link Button: Press this button to change which column of parameters the Q-Link Knobs currently control
(indicated by the lights above the Q-Link Knobs). Each press will select the next column.

Press and hold Shift and then press this button to select the previous column instead.

Press and hold this button to show the QLink window over the touchscreen’s current contents. These are the
same parameters and settings as what is shown in Q-Link Edit Mode. You can tap Q-Link Edit at the bottom of the
window to enter Q-Link Edit Mode immediately (see Operation > Modes > Q-Link Edit Mode to learn about this).

5. Pads: Use these pads to trigger drum hits or other samples. The pads are velocity-sensitive and pressure-
sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors,
depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You
can also customize their colors.

6. Pad Bank Buttons: Press any of these buttons to access Pad Banks A-D. Press and hold Shift while pressing
any of these buttons to access Pad Banks E-H. Alternatively, double-press one of these buttons.

7. Note Repeat / Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not have
to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

Full Level / Half Level: Press this button to activate/deactivate Full Level. When activated, the pads will always
trigger their samples at the maximum velocity (127), regardless of the amount of force you use.

Press and hold Shift and then press this button to activate/deactivate Half Level. When activated, the pads will
always trigger their samples at half-velocity (64).

16 Level / Pad Perform: Press this button to activate/deactivate 16 Level. When activated, the last pad that was
hit will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad,
but a selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the
minimum, Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the
Type selector to choose the parameter: Velocity, Tune, Filter, Layer, Attack or Decay. See Operation >
General Features > 16 Level to learn more.

Press and hold Shift and press this button to activate/deactive Pad Perform mode for the pads. When activated,
you can play musical scales/modes, chords or progressions using the pads while in any mode. Use the Pad
Perform window to configure the settings for the pads.

Erase: As a Sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. When playback is stopped, press this button to open the Erase window where notes,
automation and other sequence data can be erased from the sequence. See Operation > General Features >
Erase to learn more.

Undo / Redo: Press this button to undo your last action. Hold down Shift and press this button to redo the last
action you undid.

Copy / Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the
“destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap
Do It to continue or Cancel to return to the previous screen.

Press and hold Shift and press this button to delete.

Step Seg/Automation: Press this button to view Step Sequencer Mode where you can create or edit sequences
by using the pads as "step buttons," simulating the experience of a traditional step-sequencer-style drum
machine.

Press and hold Shift and press this button to toggle the Global Automation state between Read and Write.

TC / On/Off: Press this button to open the Timing Correct window, which contains various settings to help
quantize the events in your sequence.

Press and hold Shift and press this button to turn Timing Correct on and off.
Shift: Press and hold this button to access some buttons’ secondary functions (indicated by gray writing).

Double-press this button to see which buttons have secondary functions—the buttons will flash for a few
seconds.

Menu / Browse: Press this button to open the Mode Menu. You can tap an option on the Menu screen to enter
that mode, view, etc.

Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate and
select programs, samples, sequences, etc.

Main / Grid: Press this button to enter Main Mode.
Press and hold Shift and then press this button to enter Grid View Mode.

Mix / Sampler: Press this button to view the last used Mixer Mode, either Track Mixer (default) or Pad Mixer. In
Track Mixer Mode, you can set levels, stereo panning, and other settings for your tracks, programs, returns,
submixes, and masters. In Pad Mixer Mode, you can set a program’s levels, stereo panning, routing, and effects.
Pressing the button multiple times will toggle between the two Mixer Modes.

Press and hold Shift and then press this button to view the Sampler, where you can record audio samples to use
in your projects.

Mute / Sample Edit: Press this button to view the last used Mute Mode, either Track Mute (default) or Pad Mute.
In Track Mute Mode, you can mute tracks within a sequence or set mute groups for each track. In Pad Mute
Mode, you can mute pads within a program or set mute groups for each pad within a program. Pressing the
button multiple times will toggle between the two Mute Modes.

Press and hold Shift and then press this button to enter Sample Edit Mode where you can edit your samples
using various functions and processes.
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20.

21.
22.

23.

24,

25.

26.
27.
28.
29.

Next Seq / XYFX: Press this button to view Next Sequence Mode where you can trigger different sequences
simply by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.

Press and hold Shift and press this button to view XYFX Mode, which turns the touchscreen into an XY pad
where each axis represents the range of an effect parameter. As you move touch or move your finger on the
touchscreen, the current position will determine the current value of the two parameters. You can use this mode
to create interesting effect automation on your tracks.

-/+: Press these buttons to decrease/increase the value of the selected field in the display.

Tap Tempo / Master: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can
set how many taps are required in the Preferences (see Operation > General Features > Menu > Preferences
to learn how to do this).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit amber) or a master tempo (the button will be lit red).

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a Sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Press and hold Shift and press this button to stop playback and return the playhead
to 1:1:0.

Play: Press this button to play the sequence from the playhead’s current position.
Play Start: Press this button to play the sequence from its start point.
Master Vol: Turn this knob to adjust the volume of the Master L/R outputs, phones output and speakers.

Speakers: When the Speaker switch on the rear panel is set to On, these speakers will play the current audio.
Use the Master Volume knob to control the volume of the speakers.
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Rear Panel
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Power Input: Use the included power adapter to connect MPC Live Il to a power outlet.

Power Adapter Restraint: Secure the power adapter cable to this restraint to prevent it from accidentally
unplugging.

Power Switch: Turns MPC Live II’'s power on/off.

Charging Indicator: This light (behind the vent) will turn on when MPC Live II’s internal battery is charging (when

the power input is connected to a power outlet). When the battery is fully charged or when it is disconnected
from a power outlet, then this light will turn off.

Link: Connect a standard Ethernet cable to this port to use Ableton Link and other compatible devices with MPC
Live Il. See Operation > General Features > Menu > Sync for more information.

Note: You can also use Ableton Link wirelessly over a Wi-Fi connection.

USB-B Port: Use the included USB cable to connect this high-retention-force USB port to an available USB port
on your computer. This connection allows MPC Live Il to send/receive MIDI and audio data to/from the MPC
software on your computer.

USB-A Ports: Connect USB flash drives to these USB ports to access their files directly using MPC Live Il. When
connected to a computer in Controller Mode, you can access drives connected to this port from your computer.
You can also connect standard MIDI controllers to these ports.

SD Card Slot: Insert a standard SD, SDHC or SDXC card into this slot to access its files directly using MPC Live II.
Rec Vol: Turn this knob to adjust the volume of the inputs.

. Inputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to an audio source

(mixer, synthesizer, drum machine, etc.). In Sample Record Mode, you can select whether you want to record
either channel or both channels in stereo or in mono. To use these inputs, set the Line/Phono switch to Line.

Inputs (RCA): Use a standard RCA stereo cable to connect these inputs to a phono-level audio source like a
turntable. In Sample Record Mode, you can select whether you want to record either channel or both channels in
stereo or in mono. To use these inputs, set the Line/Phono switch to Phono.

Line/Phono Switch: Set this switch to the appropriate position, depending on which inputs you want to use. If
you are using the RCA inputs, set this switch to Phono to provide the additional amplification needed for phono-
level signals. If you are using the 1/4” (6.35 mm) inputs, such as a CD player or sampler, set this switch to Line.

Grounding Terminal: If using phono-level turntables with a grounding wire, connect the grounding wire to these
terminals. If you experience a low “hum” or “buzz”, this could mean that your turntables are not grounded.

Note: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be
connected to the grounding terminal.

Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your monitors,
mixer, etc.). The Master L/R outputs are the same as Outputs 1,2.

Phones (1/4” / 6.35 mm): Connect standard 1/4” (6.35 mm) stereo headphones to this output.
Speaker On/Off: Use this switch to turn the MPC Live Il internal speakers on or off.

MIDI In: Use a standard 5-pin MIDI cable to connect these inputs to the MIDI output of an external MIDI device
(synthesizer, drum machine, etc.).

MIDI Out: Use a standard 5-pin MIDI cable to connect these outputs to the MIDI input of an external MIDI device
(synthesizer, drum machine, etc.).

CV/Gate Out: MPC Live Il will send control voltage (CV) and/or Gate signals over these outputs to optional
external sequencers. Use standard 1/8” (3.5 mm) TS cables to send a single CV/Gate signal per output, or use a
stereo TRS-to-dual mono TSF breakout cable (such as a Hosa YMM-261) to send two CV/Gate signals per output.

Kensington® Lock Slot: You can use this slot to secure your MPC Live Il to a table or other surface.
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Navigation & Data Entry Controls

1. Touchscreen: This full-color multi-touch display shows information relevant to MPC One’s current operation.
Touch the display (and use the hardware controls) to control the MPC interface. See the previous Touchscreens

section to learn how to use some basic functions.

2. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field in the display. Pressing the dial also functions as an Enter button.

-/+: Press these buttons to increase or decrease the value of the selected field in the display.

4. Undo / Redo: Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

5. Shift: Press and hold this button to access some buttons’ secondary functions (indicated by red writing).
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Pad & Q-Link Controls

10.

11.

12.

13.

Pads: Use these pads to trigger drum hits or other samples. The pads are velocity-sensitive and pressure-
sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors,
depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You
can also customize their colors.

Pad Bank Buttons: Press any of these buttons to access Pad Banks A-D. Press and hold Shift while pressing
any of these buttons to access Pad Banks E-H. Alternatively, double-press one of these buttons.

Full Level / Half Level: Press this button to activate/deactivate Full Level. When activated, the pads will always
trigger their samples at the maximum velocity (127), regardless of the amount of force you use.

Press and hold Shift and then press this button to activate/deactivate Half Level. When activated, the pads will
always trigger their samples at half-velocity (64).

16 Level / Pad Perform: Press this button to activate/deactivate 16 Level. When activated, the last pad that was
hit will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a
selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum,
Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the Type selector
to choose the parameter: Velocity, Tune, Filter, Layer, Attack or Decay. See Operation > General Features > 16
Level to learn more.

Press and hold Shift and press this button to enter Pad Perform mode for the pads. When activated, you can
play musical scales/modes, chords or progressions using the pads while in any mode. See Operation > Modes
> Pad Perform Mode to learn more.

Copy / Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the “destination”
pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap Do It to
continue or Cancel to return to the previous screen.

Press and hold Shift and press this button to delete.

Note Repeat / Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.

Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can
control one column of parameters at a time. The lights above the Q-Link Knobs indicate the currently selected
column. Press the Q-Link button to change which column of parameters they currently control.

Q-Link Button: Press this button to change which column of parameters the Q-Link Knobs currently control
(indicated by the lights above the Q-Link Knobs). Each press will select the next column.

Press and hold Shift and then press this button to select the previous column instead.

Mode & View Controls

14.

15.

16.

17.

Menu / Prefs: Press this button to open the Mode Menu. You can tap an option on the Menu screen to enter
that mode, view, etc.

Press and hold Shift and then press this button to open the Preferences page in the Menu.
Main / Grid: Press this button to enter Main Mode.
Press and hold Shift and then press this button to enter Grid View Mode.

Browse / Save: Press this button to view the Browser. You can use the Browser to locate and select programs,
samples, sequences, etc.

Press and hold Shift and then press this button to to save the current project (including its samples, programs,
sequences, and songs).

Track Mix / Pad Mix: Press this button to view the Track Mixer where you can set levels, stereo panning, and
other settings for your tracks, programs, returns, submixes, and masters.

Press and hold Shift and then press this button to view the Pad Mixer where you can set a program’s levels,
stereo panning, routing, and effects.
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18.

19.

20.

21.

22.

23.

24.

Track Mute / Pad Mute: Press this button to view Track Mute Mode where you can easily mute tracks within a
sequence or set mute groups for each track.

Press and hold Shift and press this button to view Pad Mute Mode where you can easily mute pads within a
program or set mute groups for each pad within a program.

Next Seq / XYFX: Press this button to view Next Sequence Mode where you can trigger different sequences
simply by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.

Press and hold Shift and press this button to view XYFX Mode, which turns the touchscreen into an XY pad
where each axis represents the range of an effect parameter. As you move touch or move your finger on the
touchscreen, the current position will determine the current value of the two parameters. You can use this mode
to create interesting effect automation on your tracks.

Step Seq / Automation: Press this button to view Step Sequencer Mode where you can create or edit
sequences by using the pads as "step buttons," simulating the experience of a traditional step-sequencer-style
drum machine.

Press and hold Shift and press this button to toggle Global Automation between Read and Write.

TC / On/Off: Press this button to open the Timing Correct window, which contains various settings to help
quantize the events in your sequence.

Press and hold Shift and press this button to turn Timing Correct on and off.

Sampler / Looper: Press this button to view the Sampler where you can record audio samples to use in your
projects.

Press and hold Shift and press this button to view the Looper where you can record and overdub audio in real
time—a great tool for live performance as well as spontaneous moments in the studio. You can export the loop
as a sample to use in your project.

Sample Edit / Q-Link Edit: Press this button to view Sample Edit Mode where you can edit your samples using
various functions and processes.

Press and hold Shift and press this button to view Q-Link Edit Mode where you can assign other parameters to
the Q-Link knobs.

Program Edit / MIDI Control: Press this button to view Program Edit Mode, which contains all parameters for
editing your programs.

Press and hold Shift and press this button to view MIDI Control Mode where you can customize what MIDI
messages are sent from certain controls on your hardware.

Transport & Recording Controls

25.

26.

27.

28.
29.
30.

31.

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a Sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Press and hold Shift and press this button to return the playhead to 1:1:0.

Play: Press this button to play the sequence from the playhead’s current position.
Play Start: Press this button to play the sequence from its start point.
Tap Tempo / Master: Press this button in time with the desired tempo to enter a new tempo (in BPM).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit amber) or a master tempo (the button will be lit red).

Erase: As a Sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. When playback is stopped, press this button to open the Erase window where notes,
automation and other sequence data can be erased from the sequence.
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SD Card Slot: Insert a standard SD, SDHC or SDXC card into this slot to access its files directly using MPC One.
Phones (1/8” / 3.5 mm): Connect standard 1/8” (3.5 mm) stereo headphones to this output.
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Power Input: Use the included power adapter to connect MPC One to a power outlet.

Power Adapter Restraint: Secure the power adapter cable to this restraint to prevent it from accidentally
unplugging.
Power Switch: Turns MPC One’s power on/off.

Link: Connect a standard Ethernet cable to this port to use Ableton Link and other compatible devices with MPC
One. See Operation > General Features > Menu > Sync for more information.

Note: You can also use Ableton Link wirelessly over a Wi-Fi connection.

USB-B Port: Use the included USB cable to connect this high-retention-MPC One USB port to an available USB
port on your computer. This connection allows MPC One to send/receive MIDI and audio data to/from the MPC
software on your computer.

USB-A Port: Connect a USB flash drive to this USB port to access files directly using MPC One. You can also
connect a standard MIDI controller to this port.

Rec Vol: Turn this knob to adjust the volume of the inputs.

Inputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to an audio source
(mixer, synthesizer, drum machine, etc.). In Sample Record Mode, you can select whether you want to record
either channel or both channels in stereo or in mono.

Master Vol: Turn this knob to adjust the volume of the outputs and phones output.

. Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your monitors,

mixer, etc.

MIDI In: Use a standard 5-pin MIDI cable to connect this input to the MIDI output of an external MIDI device
(synthesizer, drum machine, etc.).

MIDI Out: Use a standard 5-pin MIDI cable to connect this output to the MIDI input of an external MIDI device
(synthesizer, drum machine, etc.).

CV/Gate Outs: MPC One will send control voltage (CV) and/or Gate signals over these outputs to optional
external sequencers. Use standard 1/8” (3.5 mm) TS cables to send a single CV/Gate signal per output, or use a
stereo TRS-to-dual mono TSF breakout cable (such as a Hosa YMM-261) to send two CV/Gate signals per output.

Kensington® Lock Slot: You can use this slot to secure your MPC One to a table or other surface.

29



MPC Studio Il

NOTE =
D=1z \ MPC AKAI
N STUDIO FPROFESSIONAL
32T
TOUGH
STRIP | |
® o ° TRACK SAMPLE
CONFIG I I SELECT SELECT
— PAD BANK — 1 SEQ SELEC,
32
@ I PAD 13 SAMPLER PAD 14 LOOPER PAD 15 STEP SEQ PAD 16 SAVE I
PROGRAT SAMPLE
A E ® e ° 1 ] SELECT @ START
@ 1 TRACK TYF.S LOOP START
6T
0 - - I I
BROWSE SAMPLE
@ ’ ’ . I I @ i @
c G 1 )
ll I
@ e SONG ~ PADTl MDICTRL  PAD12 NEDA E@ E@ E@ E@
D H
1 FINE
@mu TEVEL Ll | 1
Ii HALF LEVEL ® o [ ] 1 I [o= QUANTIZE [Zoom UNDO
COPY
% I ] VERT ZOOM REDO
I DELETE MAIN TC AUTOMATIC TAP
IPAD MUTE © o [ ] I I ON/OFF [READ/WRI TEMPO
PAD5 SAMPLE EDIT PAD 6 PROG EDIT PAD 7 PAD MIXER PAD 8 CH MIXER
TRACK VIEV CONFIG OFF MASTER
1
li TRACKMUTE ar I I I<< FEvenT = START END
< 0 << >
@16 LEVEL ® ° ° I I
a
Ii 4 I I RECORD OVER DUB STOP PLAY PLAY m
@ERASE START
() | 1
PAD1 TRACK VIEW PAD 2 GRID PAD 3 WAVE PAD 4 LIST EDIT

Navigation & Data Entry Controls

1. Display: This RGB LCD display shows information relevant to MPC Studio’s current operation. Much of this
information is also shown in the software. Use the Mode and Select buttons to change what is shown on the
display, and use the data dial or -/+ buttons to adjust the currently selected setting/parameter.

2. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field in the display. Pressing the dial also functions as an Enter button.

-/+: Press these buttons to increase or decrease the value of the selected field in the display.
Undo / Redo: Press this button to undo your last action.
Press and hold Shift and press this button to redo the last action you undid.

5. Shift: Press and hold this button to access some buttons’ secondary functions (indicated by white writing).

Pad & Touch Strip Controls

6. Pads: Use these pads to trigger drum hits or other samples. The pads are velocity-sensitive and pressure-
sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors,
depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You
can also customize their colors.

Press and hold the Mode button and press each pad to quickly jump to the mode printed below the pad in
orange.

7. Pad Bank Buttons: Press any of these buttons to access Pad Banks A-D. Press and hold Shift while pressing
any of these buttons to access Pad Banks E-H. Alternatively, double-press one of these buttons.

8. Full Level / Half Level: Press this button to activate/deactivate Full Level. When activated, the pads will always
trigger their samples at the maximum velocity (127), regardless of the amount of force you use.

Press and hold Shift and then press this button to activate/deactivate Half Level. When activated, the pads will
always trigger their samples at half-velocity (64).
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10.

11.

12.

13.

Copy / Delete: Press this button to copy one pad to another. Use the Copy from pad field to select the “source”
pad (the pad you want to copy) and use the Copy to pad field to select the “destination” pad. You can select
multiple destination pads, and you can select pads in different pad banks. Tap Do It to continue or Cancel to
return to the previous screen.

Press and hold Shift and press this button to view the Delete Pad window, where you can delete the contents of
a selected pad.

16 Level: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be
temporarily copied to all 16 pads. The pads will play the same sample as the original pad, but a selectable
parameter will increase in value with each pad number, regardless of the amount of force you use. Use the data
dial or -/+ buttons to select the 16 Level parameter.

Press and hold Shift and press this button to cycle through editing the Pad Perform Notes Type, Root Note, and
starting Octave. Use the data dial or -/+ buttons to adjust the parameter shown on the display.

Note Repeat / Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.

You can also change the note repeat rate using the Touch Strip.

Touch Strip: The touch strip can be used as an expressive control for playing and can be configured to control
Note Repeat, Pitch Bend, Modulation, Touch FX and more. See Appendix > Updates in MPC 2.10.1 > New
Features > Touch Strip and Touch FX for more information.

Touch Strip / Config: Press this button to enable Touch Strip mode selection. Press the button repeatedly or use
the data dial or -/+ buttons to cycle between the available modes. Press and hold this button to enter Q-Link mode
for the Touch Strip.

Press and hold Shift and press this button to view the Touch Strip Configuration window.

Mode & View Controls

14. Mode: Press and hold this button and then press a pad to quickly jump to the mode printed below the pad in

orange:

Pad 13: Pad 14: Pad 15: Pad 16:
Sampler Looper Step Sequencer Save
Pad 9: Pad 10: Pad 11: Pad 12
Next Sequence Song Mode MIDI Control Mode | Media/Browser Mode
Pad 5: Pad 6: Pad 7: Pad 8:
Sample Edit Mode Program Edit Mode Pad Mixer Channel Mixer

Pad 1: Pad 2: Pad 3: Pad 4:

Track View Grid Editor Wave Editor List Editor

15. Main / Track View: Press this button to enter Main Mode.

Press and hold Shift and then press this button to enter Track View Mode.

16. Track Select / Seq Select: Press this button to toggle between viewing MIDI Tracks and Audio Tracks, and

then use the data dial or -/+ buttons to change the selected track.
Press and hold Shift, press this button and use the data dial or -/+ buttons to change the selected Sequence.
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17.

18.

19.

20.

21.

22.

23.

24.

25.

26.

Program Select / Track Type: Press this button and use the data dial or -/+ buttons to change the Program for
the selected track.

Press and hold Shift, press this button and use the data dial or -/+ buttons to change the track type for the
selected track: Drum, Keygroup, Plugin, MIDI, Clip or CV.

Browse / Up: Press this button once to open the File Browser, and press it again to open the Media Browser.
You can use the Browsers to locate and select programs, samples, sequences, etc.

Press and hold Shift and then press this button to move up to the previous folder while using the Browser.

Sample Select: Press this button and use the data dial or -/+ buttons to change the selected sample for the
current pad. Press the button again to cycle between Layers 1-4 of the pad.

Sample Start / Loop Start: Press this button and use the data dial or -/+ buttons to change the sample start
point for the sample on the selected pad. Press the button again to cycle through Layers 1-4 of the pad.

Press and hold Shift, press this button, and use the data dial or -/+ buttons to change the Loop Start point for
the sample on the selected pad. Press and hold Shift and press the button again to cycle through Layers 1-4 of
the pad.

Sample End: Press this button and use the data dial or -/+ buttons to change the sample end point for the
sample on the selected pad. Press the button again to cycle through Layers 1-4 of the pad.

Tune / Fine: Press this button and use the data dial or -/+ buttons to change the Tuning for the sample on the
selected pad. Press the button again to cycle through Layers 1-4 of the pad.

Press and hold Shift, press this button, and use the data dial or -/+ buttons to change the Fine Tuning for the
sample on the selected pad. Press and hold Shift and press the button again to cycle through Layers 1-4 of the pad.
Quantize: Press this button to quantize all note events so they fall on exact, even time intervals as determined by
the Timing Correct settings.

Press and hold Shift and press this button to quantize only the currently selected note events.

TC On/Off / Config: Press this button to turn Timing Correct on and off.

Press and hold Shift and press this button to toggle between viewing the Time Division and Swing settings for
Timing Correct in the display. Use the data dial or -/+ buttons to change the selected value.

Zoom / Vert Zoom: Press this button and use the data dial or -/+ buttons to change the horizontal zoom level.
Press and hold Shift, press this button and use the data dial or -/+ buttons to change the vertical zoom level.
Pad Mute / Track Mute: Press this button to view Pad Mute Mode where you can easily mute pads within a
program or set mute groups for each pad within a program.

Press and hold Shift and press this button to view Track Mute Mode where you can easily mute tracks within a
sequence or set mute groups for each track.

Transport & Recording Controls

27.

28.

20.

30.
31.
32.

33.

Record: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in
this way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays
through once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a Sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Press and hold Shift and press this button to return the playhead to 1:1:0.

Play: Press this button to play the sequence from the playhead’s current position.
Play Start: Press this button to play the sequence from its start point.

Step </> (Event |</>|): Use these buttons to move the playhead left or right, one step at a time.

Press and hold Locate and press one of these buttons to move the playhead to the previous/next event in the
sequence grid.

Bar <</>> (Start/End): Use these buttons to move the playhead left or right, one bar at a time.

Press and hold Locate and press one of these buttons to move the playhead to the start or end of the sequence
grid.
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34.

35.

36.

37.

Locate: Press this button and then use the pads to add and select locator markers in the timeline. When on, tap
Pads 9-14 to set up to six locators on the timeline, and tap Pads 1-6 to jump to each locator.

Additionally, the current playhead position will be shown on the display in Bars : Beats : Ticks when this button
is activated. Use the data dial or -/+ buttons to move the playhead left or right one beat at a time or press and
hold Shift and use the data dial or -/+ buttons to move the playhead left or right one tick at a time.

To deactivate Locate, enter another display mode (such as Track Select, Program Select, etc.).
Automation Read/Write: Press this button to toggle the Global Automation state between Read and Write.
Press and hold Shift and press this button to disable or enable Global Automation.

Tap Tempo / Master: Press this button in time with the desired tempo to enter a new tempo (in BPM).
Alternatively, press and hold this button and then use the data dial or -/+ buttons to coarsely adjust the tempo.
Press and hold both Shift and this button and then use the data dial or -/+ buttons to finely adjust the tempo.

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit white) or a master tempo (the button will be lit red).

Erase: As a Sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. When playback is stopped, press this button to open the Erase window where notes,
automation and other sequence data can be erased from the sequence.

Rear Panel

ol — — — —

USB DI mIDI

E AlCAl

USB-B Port: Use the included USB cable to connect this high-retention-force USB port to an available USB port
on your computer. This connection allows MPC Studio to send/receive MIDI data to/from the MPC software on
your computer.

MIDI Out: Use the included 1/8"-to-MIDI adapter and a standard 5-pin MIDI cable
output to the MIDI input of an external MIDI device (synthesizer, drum machine, etc.

MIDI In: Use the included 1/8"-to-MIDI adapter and a standard 5-pin MIDI cable
input to the MIDI output of an external MIDI device (synthesizer, drum machine, etc.

—

not included) to connect this

~

—

not included) to connect this

~
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MPC Touch

Top Panel
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1. Touchscreen: This full-color multi-touch display shows information relevant to MPC Touch’s current operation.
Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the previous
Touchscreens section to learn how to use some basic functions.

2. Display Brightness +/-: Use these buttons to increase/decrease the brightness of the touchscreen.

Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field in the screen.

4. Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can control
one group of parameters at a time. The lights below the Q-Link button indicate the currently selected column of Q-
Link knobs. Press the Q-Link button to change which parameter or group of parameters they currently control.

5. Q-Link Button: Press this button to change which parameter or group of parameters the Q-Link knobs currently
control (indicated by the lights above the Q-Link knobs). Each press will select the next column of Q-Link knobs.

Press and hold Shift and then press this button to select the previous column of Q-Link knobs instead.

Press and hold this button to show the QLink window over the touchscreen’s current contents. These are the same
parameters and settings as what is shown in Q-Link Edit Mode. You can tap Q-Link Edit at the bottom of the
window to enter Q-Link Edit Mode immediately (see Operation > Modes > Q-Link Edit Mode to learn about this).

6. Pads: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive
and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different
colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest
velocity). You can also customize their colors.

7. Pad Bank: Press any of these buttons to access Pad Banks A-D.

Press and hold Shift while pressing any of these buttons to access Pad Banks E-H. Alternatively, double-press
one of these buttons.

8. Note Repeat/Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.
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10.

11.

12.

13.

14.

15.

16.

17.
18.
19.
20.

21.

22.

23.

Full Level/Half Level: Press this button to activate or deactivate the Full Level feature. When activated, the pads
will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

Press and hold Shift and then press this button to activate or deactivate the Half Level feature. When activated,
the pads will always trigger their samples at half-velocity (64).

16 Level / Pad Perform: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit
will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a
selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum,
Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the Type selector
to choose the parameter: Velocity, Tune, Filter, Layer, Attack or Decay. See Operation > General Features > 16
Level to learn more.

Press and hold Shift and press this button to enter Pad Perform mode for the pads. When activated, you can
play musical scales/modes, chords or progressions using the pads while in any mode. See Operation > Modes
> Pad Perform Mode to learn more.

Erase: As a sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. See Operation > General Features > Erase to learn more.

Shift: Press and hold this button to access some buttons’ secondary functions (indicated by gray writing).
Double-press this button to see which buttons have secondary functions—the buttons will flash for a few seconds.
Menu/Browse: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.

Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate and
select programs, samples, sequences, etc.

Main/Track: Press this button to enter Main Mode.

Press and hold Shift and then press this button to enter the Track View.
Undo/Redo: Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

Copy/Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the
“destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap
Do It to continue or Close to return to the previous screen.

Tip: To quickly copy a pad, press and hold Copy, press the source pad, press the destination pad, and then
release Copy.

Press and hold Shift and press this button to delete a pad’s sample assignment. When the Delete Pad window
is shown, press any pad/pads whose sample assignments you want to clear. Tap Delete to continue or Cancel
to return to the previous screen.

—/+: Press these buttons to increase or decrease the value of the selected field in the screen.
Play: Press this button to play the sequence from the audio pointer’s current position.
Play Start: Press this button to play the sequence from its start point.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all
voices and stop all audio processing.

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

Tap/Master: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how
many taps are required in the Preferences (see Operation > General Features > Menu > Preferences to learn
how to do this).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit red) or a master tempo (the button will be lit amber).
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Power Input: Use the included power adapter to connect MPC Touch to a power outlet.
Power Switch: Turns MPC Touch’s power on/off.

USB Port: Use the included USB cable to connect this high-retention-force USB port to an available USB port on
your computer. This connection allows MPC Touch to send/receive MIDI and audio data to/from the MPC software.

You can power MPC Touch via the USB port only, but the touchscreen will be disabled.

Rec Vol: Turn this knob to adjust the gain of the incoming signal from the inputs. Be careful when setting this
knob at higher levels, which can cause the signal to distort.

Master Vol: Turn this knob to adjust the volume of the outputs and phones output.

Inputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to audio sources
(microphone, mixer, synthesizer, etc.). Turn the Rec Vol knob to set their input levels.

Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your speaker
system, external mixer, etc. The signal sent out of these outputs is the master mix. Turn the Master Vol knob to
set the volume level.

Tip: To route a program to these outputs, set its routing to Out 1,2 in the Channel Mixer when the Mixer field is
set to Programs. See Operation > Modes > Channel Mixer to learn more about this.

Phones (1/8” / 3.5 mm): Connect standard 1/8” (3.5 mm) stereo headphones to this output. Turn the Master Vol
knob to set the volume level.

MIDI Out (1/8” / 3.5 mm): Use the included 1/8”-to-5-pin adapter and a five-pin MIDI cable to connect this
output to the MIDI input of an optional external MIDI device.

Important: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI Out. Use the included
1/8”-to-5-pin adapters to connect MIDI devices only.

. MIDI In (1/8” / 3.5 mm): Use the included 1/8”-to-5-pin adapter and a five-pin MIDI cable to connect this input to

the MIDI output of an optional external MIDI device.

Important: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI In. Use the included
1/8”-to-5-pin adapters to connect MIDI devices only.

Kensington® Lock Slot: You can use this slot to secure your MPC Touch to a table or other surface.
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Basic Concepts

This chapter should help explain some fundamental aspects of the MPC universe.

The MPC workflow is quite different from traditional digital audio workstations (DAWSs). In most typical DAWSs, each track
uses an instance of each instrument, and all tracks are always playing even if they don’t contain any audio or MIDI
information. Furthermore, your entire project needs to be arranged just as the resulting song would be. This isn’t the case
with MPC, which offers much more flexibility within your project. It's important to understand some basic terms, though:

A sequence is a “building block” of a song. It contains multiple tracks that play at the same time like a normal
DAW. In a project, you might create one sequence for your verse and another sequence for your chorus, alternating
and/or repeating each one in a specific order to create the song. (A project can contain 128 sequences.)

A track is a layer in a sequence. There are two types of tracks:

MIDI tracks consist of MIDI data only, no audio data. These tracks produce sound by using programs,
described below. Unlike a normal DAW, each MIDI track exists only in its sequence. The advantage of this is
not having to manage empty or unwanted tracks across all of your sequences—each sequence contains only
the tracks you want to use in it. If you want to use the same track across multiple sequences, you can copy
the track from one sequence into another. (A sequence can contain 128 MIDI tracks.)

Audio tracks consist of a recorded audio signal, like a traditional DAW. These tracks do not use programs
because the audio is already contained in the track. Also, unlike MIDI tracks, audio tracks are present in
every sequence in the project, even if the tracks themselves are empty. (A sequence on your MPC hardware
can contain 8 audio tracks. A sequence in the MPC software can contain 128 audio tracks.)

A program is a preset through which MIDI tracks are routed. Programs may contain audio samples that are
triggered when tracks play through them, producing the sound you want on that track. Programs are
independent of tracks and sequences, so you can set multiple tracks to use the same program (unlike normal
DAWSs where each track requires its own set of samples). Furthermore, you can use the same program/programs
across multiple sequences. (A project can contain 128 programs.)

Each program can be played using the 16 pads (across eight pad banks, which gives you access to 128 pads in
each program). Each pad plays a MIDI note when you press it, but that MIDI note will trigger something different
for each program. For instance, in drum programs, the pads are assigned to samples—one pad could trigger a
kick drum sound and another could trigger a snare drum sound—whereas in keygroup programs, each pad
triggers a MIDI note that plays the corresponding pitch of the sample assigned to its keygroup.

Here’s a diagram to illustrate an example of how these pieces could work together:

"= Sequence Bl B Drum Program
- / Bl ©Orums)
== Track (MIDI: Drums) ”
“ Keygroup Program
== Track (MIDI: Bass) t—> (Bass)
\ ====
:— Track (MIDI: Keys 1) p— “ Keygroup Program ===
el (Keys) ====
= . > — > EEE=
mm Track (MIDI: Keys 2) SIS
—
—_— “ Keygroup Program o |0 |0 [O
= Track (MIDL: Synth) > (Synth Lead) / T | T | T | [‘l] |
il Track (Audio: Vocals) I I I I
Mixing
I|I|I Track (Audio: Vocals)

il Track (Audio: Guitar)

Please take a look at the following Tutorial chapter, as well. It will walk you through the creation of a short song to
show you some of your MPC hardware’s most important features.
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Tutorial

This chapter should familiarize you with some basic MPC features. We'll create a short song to illustrate some of the
most important features. To get the most out of this chapter, we recommend reproducing each of the described steps.

Starting Up

Make sure you have completed all of the steps described in Introduction > Setup. This includes:
e Installing the most current drivers and software.

e Connecting your MPC hardware to a power source using the included power adapter (if required) and
powering it on.

e Opening and authorizing your MPC software (if you are using your MPC hardware as a controller).

Creating a Drum Kit

Let’s start by making a simple drum kit.

OO D @& = B B [nternal] /£

Search directory X

O,  Search directory

« o 5 = BEM « o+ v O

| Exports

NAME (492 items|
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& Acoustic-Kit-Ac Fat Kit.xpm

I \VIPC Documents
i Acoustic-Kit-Ac Rock Kit.xpm

B |egacyExports

Midi Learn stic-Kit-Ac Tight Kit.xpm

Plugin Presets Kit-Ac Vintage Kit.xpm

Plugin Skins coustic-Kit-Drum Pimp Chop.xpm

Programs & Acoustic-Kit-TL Jr Live Kit.xpm
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Press Browse (MPC X, MPC One, MPC Live ll) or Shift+Menu/Browse (MPC Live, MPC Live Il, MPC Touch) to
show the Browser. Then, use the touchscreen to navigate to where your drum sounds are located:

To browse your files by location, tap Places on the left side of the screen.
Internal is the internal drive of MPC X, MPC Live, MPC Live Il or MPC One.

MPC Documents is a shortcut to the MPC Documents folder on the internal drive of MPC X, MPC Live,
MPC Live Il or MPC One.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, MPC Live Il, MPC
One, or your computer (with MPC Live Il and MPC Touch), they will appear in this column, as well.

Important: MPC hardware supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems
as well as read-only capability for HFS+ file systems. (We recommend using an exFAT file system as it is the
most robust one supported by both Windows and macOS.)

To browse your files by type, tap Content and then tap the type of file: Drums, Instruments, Clips, Samples,
Demos, or My Files.

To browse your MPC Expansions (MPC X, MPC Live, MPC Live Il or MPC One only), tap Expansions (see
Addenda > Updates in MPC 2.1 > New Features > Exporting Expansions to learn how to export MPC
Expansions from your computer to your supported MPC hardware.

To move up one folder level, tap the folder/1 icon in the upper-left corner.
To move through a list, swipe up or down, turn the data dial or use the —/+ buttons.
To select a file or folder, tap it once.

To enter a folder, double-tap it or tap Open in the lower-right corner. Alternatively, press the data dial, or press
the center cursor or Enter (MPC X), to enter a selected folder.
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After loading samples for a drum kit into the sample pool,
use the Sample Assign tab to assign a kick drum sound to
a pad:

A
i 1980Kick1
i (ick2

1.

To load a selected file, double-tap it, tap Load, press the data dial, or press the center cursor or Enter (MPC
X). If the file is a sample, it will be loaded to the project’s sample pool. If the file is a project, it will be loaded in its
entirety (you will be asked if you want to close your current project).

To load all files in a folder, select the folder (so it is highlighted in the list), press and hold Shift, and then tap
Load All in the lower-right corner.

Important: Although you can load multiple files at once, any samples you load into a project will be automatically
converted to full-quality uncompressed audio files, so they may use more storage space than they do on your
external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again.

To delete a selected file or folder, press and hold Shift and then tap Delete File at the bottom of the screen.
To preview a selected sound, tap and hold Play (») at the bottom of the screen.

To enable or disable the audition function and set its volume level, tap Audition at the bottom of the screen.
In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or down to set
the volume level. Tap Audition once more to hide the window.

To show the information for the current drive (MPC X, MPC Live, MPC Live Il, MPC One), press and hold Shift
and then tap Drive Info at the bottom of the screen. The drive’s information will appear in a new window. Tap
OK to return to the previous screen.

- Program 001

Tap Sample Assign at the bottom of the screen. This
lets you view the pads and project’s sample pool.

Press Pad 1 or tap Pad 1 on the screen to select it. The
pad will be lit green.

Swipe the Sample Pool list up or down or use the data
dial or —/+ buttons to move through it.

To load a sample to the selected pad (Pad 1, in this
case) tap it in the Sample Pool list, press the data dial, 0 auorrion
or press the center cursor or Enter (MPC X). Now, you

can press Pad 1 to play the kick drum sample.

To create a simple drum Kkit, repeat the above steps for
other pads. We recommend loading a snare drum, a closed
hi-hat, and an open hi-hat.
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Creating a Drum Sequence

Now that your drum kit is set up, let’s record a drum sequence.

=
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1. Press Menu to enter the Menu, and then tap Grid View.

2. Press Tap repeatedly at the speed you want to record your sequence. Your MPC hardware will detect the rate
and adjust itself automatically.

Press the Rec button to record-arm the sequence.

Press the Play button to start the actual recording. You will hear the count-in for one measure before the
recording starts. We recommend recording only one sound (pad) at a time, especially if you're not familiar with
playing drums on the pads.

5. Play a simple kick drum pattern. The note events you just recorded will automatically be placed in the grid (in this
case, on 16th notes). The initial measure length is two bars. After the two bars, the recording will automatically
activate Overdub; the sequence will play again from the beginning and keeps looping, allowing you to record
further notes. Don’t stop the recording!

6. Play the snhare drum part, then a hi-hat part.

When you’re done recording, press the Stop button.

If you start recording again on this sequence, keep in mind that the pads you play in your new recording will replace
existing notes played with the same pads. To prevent this, press the Overdub button before recording instead of the
Rec button. Overdub lets you record additional note events over the existing sequence.

The Undo button functions differently while recording. Normally, pressing Undo will undo just the last event. When
there is an event to undo, the Undo button will be lit solid. While recording, the Undo button will flash. In this case,
pressing Undo will erase all events from that recording (i.e., since Play or Play Start was pressed).
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Saving & Renaming

We recommend doing some renaming of your programs and samples before going further.

The collection of drum samples you loaded earlier (and their respective pad assignments) are arranged into a
program. When you load this program in the future, you will be able to use all of the samples that belong to it.

Let’s rename the existing program as we’ll want to create more programs later on.

€ Set program name

Program 001

To rename a program:
1. Press Main to enter Main Mode.
2. Inthe Program section in the lower part of the screen, tap the cursor icon on the right edge.

3. Use the virtual keyboard that appears to enter a new name (e.g., Drums), and then tap Do It.

To rename your samples:
1. Press Menu to enter the Menu, and then tap Sample Edit to enter Sample Edit Mode.

2. The Sampile field at the top of the screen will show the name of a sample. Select a sample in one of the following
ways:

o When the Sample field is selected, use the data dial or —/+ buttons to change it.
e Double-tap the Sample field and tap one in the list that appears.
Tap the keyboard icon next to it to rename the current sample.

4. Use the virtual keyboard that appears to enter a new name (e.g., Kick, Snare, etc.), and then tap Do It.

Repeat Steps 2-4 to rename other samples.
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Now would be a good time to save your project.
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To save your project, press Menu to show the Menu, and tap the disk icon at the top of the screen to open the
Save window. Alternatively, press Shift+Browse/Save (MPC X, MPC One). In the Save window, do any of the
following:

To select the storage device you want to view, tap it in the Storage column on the left.
Internal is the internal drive of MPC X, MPC Live, MPC Live Il or MPC One.

MPC Documents is a shortcut to the MPC Documents folder on the internal drive of MPC X, MPC Live,
MPC Live Il or MPC One.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, MPC Live Il, MPC
One or your computer (with MPC Studio or MPC Touch), they will appear in this column, as well.

To enter a folder, double-tap it. Alternatively, turn the data dial or use the =/+ buttons to move through the list,
and press the data dial, or the center cursor or Enter (MPC X), to enter a folder. You can also tap one of the
five folder buttons in the upper-right to jump immediately to those pre-assigned file paths (see Operation >
Modes > Browser to learn how to do this).

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap
Do It. You will immediately enter the new folder.

To move up one folder level, tap the folder/L icon in the upper-left corner.
To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.
To save the file, tap Save.

To cancel and return to the Menu, tap Cancel. Alternatively, tap the € icon in the upper-left corner.
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Editing Note Events

In the grid, you can see your recorded notes (or note events) as a sequence.

To enter the Grid View, press Menu, and then tap Grid View.

ey Velocity
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In the Grid View, you can do any of the following:

To zoom in or out, tap the magnifying-glass icon in the upper-right corner. Then, in the grid, spread two
fingers apart or pinch two fingers together. You can do this for each axis, horizontal or vertical.

To automatically set the grid to view one pad bank and two bars, tap the grid-and-magnifying-glass icon in
the lower-left corner.

To undo your last action, press Undo.

To redo the last action you undid, press Shift+Undo/Redo.

To enter a note, tap the pencil icon in the upper-right corner. Then, in the grid, tap a square.

To delete a note, tap the eraser icon in the upper-right corner. Then, in the grid, tap a note.

To select a single note, tap the select box in the upper-right corner. Then, in the grid, tap the note.
To select all notes for a pad, press the desired pad.

To move the selected notes, tap Nudge at the bottom of the screen, and then use the data dial or —-/+ buttons
to shift the notes left or right. By default, you can position notes only by quantization values defined by the Time
Correct value (learn about this feature in Operation > General Features > Timing Correct (TC)).

To move the selected notes without restricting (“snapping”) them to the quantization grid, tap and hold
Don’t Snap in the lower-left corner of the screen, and then use the data dial or —/+ buttons to shift the notes. In
this case, each nudge is equivalent to four ticks.

To adjust the start point or end point of the selected notes (without changing their position), tap Edit Start or
Edit End at the bottom of the screen, and then use the data dial or —/+ buttons.

To transpose the selected notes up or down, tap Transpose at the bottom of the screen, and then use the
data dial or —/+ buttons.

To switch to the previous or next track, tap the Track field in the upper-left corner, and then use the data dial
or —/+ buttons.

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the
screen.
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To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the screen. See
Operation > General Features > Timing Correct (TC) to learn about this.

To adjust the velocity of the selected notes, tap Velocity at the bottom of the screen, and then use the data
dial or -/+ buttons. The numeric value will appear on the screen.

To show or hide the velocity lane, tap the up arrow (A) button in the lower-right corner of the screen to show
the velocity lane below the grid. Each note’s velocity is represented by a vertical bar. The higher and more red
the bar is, the higher the velocity is.

Tap the up arrow (A) button once more to show a taller version of the velocity lane after which it will turn into a
down arrow (v) button, which you can then tap to hide the velocity lane.
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Making Basic Sound Edits

Let’s make sure the samples are properly tuned and have good levels.

Press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X, MPC
One).

Program 1

MASTER PAD A07 SIMULTANEOQUS PLAY MUTE TARGET

VELOCITY

ONE SHOT

MASTER SAMPLES ENVELOPES MODULATIONS EFFECTS

Press a pad to show its parameters on the screen.

To adjust its volume, tap and drag the Level knob up or down. Alternatively, use the data dial or —/+ buttons.
To make finer adjustments, double-tap the knob and adjust the larger version that appears. Tap anywhere else
to return to the previous screen.

To adjust its stereo panning, tap and drag the Pan knob up or down. Alternatively, use the data dial or —/+
buttons. To make finer adjustments, double-tap the knob and adjust the larger version that appears. Tap
anywhere else to return to the previous screen.

Adjust the level of each pad to suit your taste. We recommend spreading the panning of the bright sounds (e.g.,
cymbals, snare drum) a little. Additionally, you can tune the kick drum sound—tap the Samples tab so the second
square under it is lit, and then adjust the Semi and Fine knobs next to the sample name.
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The snare drum may need some reverb to give it a more spatial sound.

Tap Effects at bottom of the screen so the first square under it is lit to view the Insert Effects tab. Press the pad
with your snare drum sound to select it.

(]
(]

Program 1
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To add an effect:
1. Double-tap the desired slot. A list of effects will appear.
2. Swipe up or down to move through the list.

3. To load an effect, double-tap it. Alternatively, tap it once and then tap Select or push the data dial. Let’s try
Reverb Medium.

4. To close the list, tap Close.

To adjust the effect’s parameters, tap the pencil icon.
To empty the effect slot, tap the trash can icon. Switch the effect on or off by tapping the On/Off button for the slot.
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Creating a Bass Track

Let's try recording a bass line. Unlike a drum kit, it’'s important to be able to play and record a bass sound
chromatically, so this will be slightly different than setting up the drum kit.

Adding a bass line over the drum part means we need to work on a new track. A track is simply a layer of a sequence.
Each track uses a program within your project. You can work with multiple tracks in a single sequence (e.g., a drum
track, a bass track, a piano track, etc.). When you play the sequence, all of them will play simultaneously.

First, let’s make an empty track.
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To select a new track:
1. Press Main to go back to Main Mode.

2. Double-tap the Track field in the center-left part of the screen, and then tap Track 2 (unused) in the list of tracks
that appears.

Alternatively, tap the Track + button at the bottom of the screen until (unused) appears in the Track field.

Let’s create a new program for this track to use.
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To create a new program:

1. In the Track section in the middle of the screen, tap the piano-keys icon. This icon indicates a keygroup
program, which is nhecessary to play the bass sound chromatically with the pads.

A name for the new keygroup program will appear in the Program field in the lower part of the screen.
2. Inthe Program section in the lower part of the screen, tap the cursor icon on the right edge.
3. Use the virtual keyboard that appears to enter a new name, and then tap Do It.
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LAYER 1

MASTER SAMPLES ENVELOPES PORTA / MOD EFFECTS

To load and edit a bass sound:

1.

Press Browse (MPC X, MPC One, MPC Studio) or Shift+Menu/Browse (MPC Live, MPC Live Il, MPC Touch) to
show the Browser. Then, use the touchscreen to navigate to where your bass sounds are located, and load one
to the project’s sample pool. (You can look at this earlier section if you forgot how to do this!)

After loading a bass sample to the sample pool, don’t use the Sample Assign tab like you did when creating a
drum program; keygroup programs are different.

Instead, press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X,
MPC One).

In Program Edit Mode, tap the Samples tab at the bottom of the screen to show the four layers of samples in the
program.

Double-tap the first Layer field and then tap your bass sample in the list on the left. Because you’re working with
a keygroup program instead of a drum program, this sample is now playable across all pads.

Tip: On your MPC hardware, press the Pad Bank D button to switch to Pad Bank D and press Pad 13. You
should hear the bass sample played back with its original pitch. You can use the other pads to play your sample
chromatically.

lone | SMP
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Let’'s add a second layer and set the layers’ velocity ranges so the bass will sound different when played at a higher
velocity (as a real bass would):

1.

3.
4.

Press Browse (MPC X, MPC One, MPC Studio) or Shift+Menu/Browse (MPC Live, MPC Live Il, MPC Touch) to
show the Browser, select a different bass sample that sounds similar but a little bit brighter, and load it to the
project’s sample pool.

Return to Program Edit Mode, and in the Layer tab, double-tap the second Layer field, and select the new bass
sample. Press a pad to hear both samples will sound at once. Maybe this new sound is interesting as it is, but
let’s make some quick edits to get as close as we can to a real-life bass sound.

Tap the Pan Velocity tab to show its parameters.
Tap Layer 1's Vel End knob and turn the data dial to set it to 80. Do the same to set Layer 2’s Vel Start slider to 81.

Now when you press a pad, the lower velocities (0-80) will trigger the Layer 1 sample only, while higher velocities
(81-127) will trigger the Layer 2 sample only.
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Let’s record that bass line now. Prepare your recording as described earlier, and record some bass notes. You can
edit your recording just like we’ve done earlier.
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Once you’ve recorded it, let’s tweak the sound a bit in the Filter section:
1. In Program Edit Mode, tap the Filter/Env tab to show its parameters.
2. Double-tap the Type drop-down menu, and select a filter. Let’s try working with Lowpass 2 Pole.

3. Tap the Cutoff or Reso (resonance) knob, and turn the data dial to adjust their settings until your bass sample
sounds good to you.

4. In the Amp Envelope section, tap the Attack or Release knob, and turn the data dial to adjust their settings.
These control the overall level characteristics of the sound.

Do you want to add an effect? Do this in the Effects tab:
1. Tap the Effects tab to show the insert effects.
Double-tap one of the Inserts slots to show a list of available effects.
3. Double-tap the effect you want to add to your bass line, or click Close to cancel.

To adjust the settings of the effect, click the pencil icon next to its slot to open a window that shows its
parameters.

To activate or deactivate all insert effects for that program, click the All On/All Off button in the upper-right
corner.

So far, we’ve created a simple drum sequence and a bass line to go with it. Repeat this process to create a second
sequence.
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Recording an Audio Track

We've already created some MIDI tracks, so let’s record some actual audio for our next track:
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1. Press Main to go back to Main Mode.
2. Tap the Audio tab at the bottom of the screen. Audio 001 will appear in the Track field.

If the channel strip is not already shown on the left side of the screen, tap Input Config (in the lower part of the
screen) or the small eye icon (in the upper-left part of the screen) to show it.

4. Connect a synthesizer or other line-level audio source to the 1/4” (6.35 mm) input/inputs on your MPC
hardware’s rear panel, and set the Line/Phono selector to Line (MPC X, MPC Live, MPC Live ll).

5. Double-tap the first field (Input __) and select Input 1 or Input 1,2 (depending on your audio source) as the input
source.

6. If the second field is not set to Out 1,2, double-tap it and select that option as the output.

Tap the Monitor button to cycle through its three states until it reads Auto (you will hear incoming audio while
the track is record-enabled only).

8. Turn the 3/4 Rec Gain (MPC X) or Rec Vol (MPC Live, MPC Live Il, MPC One, MPC Touch) knob to set the input
level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed
the maximum level (the meter should not be “peaking” constantly).

9. If Solo and Mute are on, tap or press them so they are off. Also, tap the automation button so it is off/gray (not
green/Read [R] or red/Write [W]). Alternatively, press Read/Write (MPC X).

10. Tap the Record Arm button to record-enable the track. Alternatively, press Rec Arm (MPC X).
11. Press Rec to record-arm the sequence.

12. To start recording, press Play or Play Start—then play your audio source! You should hear your existing
sequence playing in the background.

To stop recording, press Stop.

Record another audio track for your other sequence: Select the other sequence in Main Mode, and create another
audio track (Audio 002) to go with that sequence.
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Creating a Song

This section explains how to make a song out of your sequences. Before starting, make sure that you have recorded
some sequences (which we described earlier).

To enter Song Mode, make sure playback is stopped, and then press Menu, and then tap Song to enter Song Mode.
Alternatively, press Song (MPC X).
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In Song Mode, each of the sequences you’ve created in this project assigned to a pad. The sequence playlist is to
the left of the pads, showing the song’s structure.

As a song plays, it moves through each step of the sequence playlist. Each step contains a sequence you assigned.
Each step can be repeated, determined by the value in the Repeat column (the repeat icon; a value of 1 means the
sequence will play through only once). The Bars column on the right indicates the length of that sequence.

Each step can be set to play its sequence at an independent tempo, determined by the value in the BPM column.

Important: Each sequence has its own tempo, while the project itself may use a different master tempo. The BPM
value for each sequence may be different from the master tempo. As long as playback is set to follow the master
tempo, each sequence’s individual tempo will be ignored. By default, each project is set to use the sequence tempo,
which you set back in the Creating a Drum Sequence chapter. We recommend tapping the Seq/Mst button at the
top of the screen (so the button displays Mst) and entering a master tempo to ensure all sequences use the same
tempo.

To insert a step at the current position, tap Insert.
To delete the currently selected step, tap Delete.

To set which sequence plays for a step, tap the step’s Sequence field, and then turn the data dial to select a
sequence.

To set how many times a sequence repeats, tap the step’s Repeat field (next to the sequence name), and then
turn the data dial to select a number.
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Exporting the Song

Want to share your new song? Just export it first.

< Audio Mixdown
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CANCEL EXPORT

To export a song:
1. While in Song Mode, tap Export at the bottom of the screen.
2. Inthe Audio Mixdown screen that appears, do the following:
e Make sure the Start field is set to 1, and set the End field to the last bar of your song.
o Tap the Audio Tail field and turn the data dial to set it to 2 seconds.
e Asyou’ll likely share the song online, tap the mp3 file format option in the lower-left corner.
3. Tap Export. Choose where you want to save the song.

To name the song, tap the File Name field, and use the virtual keyboard that appears to enter a new name, and
then tap Save to start exporting.
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Other Features Explained

This chapter describes various advanced features. For a fuller explanation of these features, please refer to their
corresponding sections in the Operation chapter.

Step Sequencer

You've already learned how to record note events on a track, but you can quickly enter note events in the Step
Sequencer by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum
machine.

To enter the Step Sequencer, press Menu, and then tap Step Sequencer. Alternatively, in some modes, you can
tap the steps icon on the left edge of the screen. You can also press Step Seq (MPC X, MPC Live Il, MPC One).
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1. Let’s create a sequence on a new track. Tap the Track field in the upper-left corner, and then use the data dial or
—/+ buttons to select an (unused) track. Alternatively, double-tap the Track field, and then tap a track to select it.

2. Tap the Track Length field at the top of the screen to set a length for the track, and then use the data dial or the
—/+ buttons to select a length. If you select the minimum value, Sequence, the track will be however long your
sequence is.

Tip: This lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence
repeatedly under a 4-bar bass line.

3. Tap the Bar -/+ buttons at the bottom of the screen to select the bar whose steps you want to create or edit.
The bar number will appear in the Bar field in the upper-left corner.

4. Tap the Pad -/+ buttons at the bottom of the screen to select the pad whose steps want to create or edit. The
pad number will appear in the Pad field in the upper-left corner.

Press Play to start your sequence.

Each pad represents a step in the bar. If the pad already has note events on the selected track, the corresponding
pads (steps) will be lit with colors corresponding to their velocities.

To enter a note at a step, press an unlit pad. The pad will light up with a color corresponding to its velocity.
To delete the note from a step, press a lit pad. The pad will become unlit.

To delete all notes from the entire bar, press and hold Shift, and then tap Clear Bar in the lower-right corner.

See Operation > Modes > Step Sequencer to learn more about this feature.
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Drum Loops & Chop Mode

Modern music producers often use drum loops to add grit and nuance to programmed beats. This section explains
how to use Sample Edit Mode to work with drum loops.

Use the Browser to locate a drum loop, and then double-tap it to add it to the current program. The loop does not
have to match the tempo of anything in the project.

To enter Sample Edit Mode, press Menu, and then tap Sample Edit to enter Sample Edit Mode. Alternatively,
press Sample Edit (MPC X, MPC One), or Shift+Mute/Sample Edit (MPC Live II).
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1. Tap the Sample field at the top of the screen, and then use the data dial or —/+ buttons to select the loaded
drum loop. You can scroll through all loaded samples in the project. Alternatively, double-tap the Sample field,
and then tap a sample to select it.

2. Tap the Trim/Chop tab in the lower-left corner to switch between Trim Mode and Chop Mode. Select Chop
Mode, which will let us cut the drum loop into slices.

3. Tap Threshold, and then tap the Threshold field to the right of it. Use the data dial, —/+ buttons, or numeric
keypad (MPC X) to select a value. Alternatively, double-tap the Threshold field and use the numeric keypad on
the screen. The lower the threshold, the more slices will be created. Be sure to select a value so that every
transient peak of the drum loop has a corresponding a slice marker.

Tip: Each slice will be automatically assigned to a pad: Pad AO01 plays Slice 1, Pad A02 plays Slice 2, etc. Press
each pad to play the slice with the same number.

54



Let’s use this chopped sample to create a new program in which each of these slices is an individual sample. We
can also automatically create corresponding note events to play back these slices sequentially.
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Press and hold Shift and then tap Convert at the bottom of the screen to enter the Convert or Assign Slices
window.

Tap the Convert To field, and then use the data dial or —/+ buttons to select New Program with New Samples.
Make sure Crop Samples is checked. If it is not, tap it.

Make sure Create New Program is checked. If it is not, tap it.

Make sure Create Events is checked. If it is not, tap it.

Tap the Bars field, and then use the data dial or —/+ buttons to select how many bars the entire sample should
use in your program.

Tap Do It to proceed. Each slice will be assigned to a pad, and each pad will have a recorded note event in the
track. When you play that track, it will play each pad (each slice) in the original order. Press Menu and then tap
Grid View to see how the sample appears in your sequence.

Press Play and listen to how the drum loop matches your song tempo now.

You can also edit the note events of the drum loop slices—enter Main Mode to do this. A new track with the note
events playing their corresponding slices has been automatically created. Tap the TC/clock icon at the top of the
screen to use the Timing Correct window to quantize the note events so they fall on exact, even time intervals.

You can also rearrange the note events, thus creating a new playback order for the slices. You can also edit each
slice or sample in Program Edit Mode. You can add effects for slices or use the filter function to change the
frequency range of a selected slice. There are almost no limits to what you can do.

See Operation > Modes > Sample Edit Mode > Chop Mode to learn more about this feature.
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Pad Muting & Track Muting

Pad Mute Mode and Track Mute Mode let you silence different pads and tracks to see what the sequence sounds
like without those samples or parts.

To enter Pad Mute Mode, press Menu, and then tap Pad Mute to enter Pad Mute Mode. Alternatively, press
Shift+Track Mute/Pad Mute (MPC X, MPC One).
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1. Press Play to play the sequence.

2. Tap the Program field at the top of the screen, and then use the data dial or —/+ buttons to select your drum
program. Alternatively, double-tap the Program field, and then tap a program to select it.

3. Mute a pad by pressing it once or tapping it on the screen. The muted pad will be lit red. You can mute multiple
pads at the same time.

See Operation > Modes > Pad Mute Mode to learn more about track mutes.
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You can also mute entire tracks by using the similar Track Mute function.

To enter Track Mute Mode, press Menu, and then tap Track Mute to enter Track Mute Mode. Alternatively, press
Track Mute (MPC X, MPC One).

- Sequence 04
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1. Press Play to play the sequence.

2. Tap the Sequence field at the top of the screen, and then use the data dial or —/+ buttons to select the desired
sequence. Alternatively, double-tap the Sequence field, and then tap a sequence to select it.

3. Each pad is assigned to a track. Mute a track by pressing the corresponding pad or tapping it on the screen. The
pad will be lit red. You can mute multiple tracks at the same time.

Tip: To mute a track only at precise note intervals (“quantizing” your mutes, essentially), tap Time Division to set
a musical timing value. Tap the desired musical value (e.g., 1 Bar). Alternatively, use the data dial or —/+ buttons. Tap
Close to close the page. Now, when you press a pad in Track Mute Mode, the mute will occur precisely at the
beginning of the following time division (in this example, one bar). This lets you test musical combinations of
patterns—the preliminary stage to building a song structure.

See Operation > Modes > Track Mute Mode to learn more about track mutes.
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Sampling (Recording)

This section describes recording new samples of your own, which you can use in your projects.

Important: To record any audio, you need to connect an audio source to your MPC hardware or to your computer’s
audio interface.

To open the Sampler, press Menu, and then tap Sampler to enter Sampler Mode. Alternatively, press Sampler
(MPC X, MPC One), or press Shift+Mix/Sampler (MPC Live lI).

SLICE +

1. Connect an audio source to the input/inputs of your MPC hardware.

2. The Input __ menu in the upper-left corner should be set to Input 1,2 (the inputs of your MPC hardware). If it is
not, then select Input 1,2.

3. Turn the 3/4 Rec Gain (MPC X) or Rec Vol (MPC Live, MPC Live ll, MPC One, MPC Touch) knob to set the input
level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed
the maximum level (the meter should not be “peaking” constantly).

4. Tap and drag threshold slider to set the threshold. Alternatively, use the data dial or —/+ buttons. Set it to a
fairly low level (e.g., -50 dB).

Tap Arm to record-arm the Sampler.

Play your audio source. The Sampler will start recording immediately when the input level reaches the threshold
value. Alternatively, tap the round Record button to manually start recording.

7. To stop recording, tap the round Stop button. The Keep or Discard Sample window will appear.
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Al KEEP OR DISCARD SAMPLE

New Sample

Drums

DISCARD

In the Keep or Discard Sample window:
To name the new sample, tap the Edit Name field and use the virtual keyboard to enter a name.

To assign the new sample to a program, tap the Program field, and then use the data dial or —/+ buttons to
select the desired program. Alternatively, double-tap the Program field, and then tap a program to select it.

To assign the sample to a pad in the program, tap the Assign to Pad field, and then press the desired pad.
Alternatively, use the data dial or —/+ buttons to select the desired pad number, or double-tap the Pad field, and
then tap a pad number.

To set the Root Note for the sample, tap the Root Note field, and then then use the data dial or —/+ buttons to
select the desired note.

To save the sample, tap the Save button at the bottom of the screen.
To play the recording, tap the Play button at the bottom of the screen.

To discard the recording and return to the previous screen, tap the Discard button at the bottom of the
screen.

To confirm your selections, tap Keep at the bottom of the screen.

To edit the sample in Sample Edit Mode, tap the Edit button at the bottom of the screen.

See Operation > Modes > Sampler to learn more about this feature.
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Sample Editing

You may need to edit your newly recorded samples using Sample Edit Mode.

To enter Sample Edit Mode, press Menu, and then tap Sample Edit to enter Sample Edit Mode. Alternatively,
press Sample Edit (MPC X, MPC One), or press Shift+Mute/Sample Edit (MPC Live II).
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In Sample Edit Mode:

To switch between Trim Mode and Chop Mode, tap the Trim/Chop tab at the bottom of the screen. In this
example, use Trim Mode.

To set the sample’s start point, use the first column of Q-Link knobs (when in the Screen Q-Link Edit Mode)
to adjust the start point with varying degrees of resolution. Alternatively, tap and drag the S marker in the
waveform. You can also double-tap the Start field and use the numeric keypad on the screen to enter a value (or
tap the Start field and use the numeric keypad).

To set the sample’s end point, use the second column of Q-Link knobs (when in the Screen Q-Link Edit
Mode) to adjust the end point with varying degrees of resolution. Alternatively, tap and drag the E marker in the
waveform. You can also double-tap the Start field and use the numeric keypad on the screen to enter a value (or
tap the Start field and use the numeric keypad).

To hear your edits, press Pad 10 to play the sample from the start point to the end point.
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Let’s apply some processing to the sample.

To open the Process Sample window, tap Process at the bottom of the screen.

[l  PROCESS SLICE

FUNCTION CANCEL

1. Use the data dial or —/+ buttons to select the desired process in the Function field. Alternatively, tap Function
or double-tap the Function field, and then tap the desired process. Let’s select Pitch Shift to change the overall
pitch of your sample. This will transpose the sample without affecting its length.

2. To set the pitch shift amount, tap and drag the knob in the center of the window up or down. Alternatively, use
the data dial or —/+ buttons.

To make finer adjustments, double-tap the knob and adjust the larger version that appears. Tap anywhere else
to return to the previous screen.

3. To confirm your selections, tap Do It.

To cancel the process, tap Cancel.

See Operation > Modes > Sample Edit Mode to learn more.
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Recording Automation with the XY Pad

Automating various parameters is a good way to add some motion and dynamism to your sequences.

10.
11.

X

Program

HPF Manual

Press Menu, and then tap XYFX to enter XYFX Mode. Alternatively, press XYFX (MPC X), or press Shift+Next
Seq/XYFX (MPC Live ll, MPC One).

Double-tap the XYFX Location field, and select Program.

When you first enter this mode in a project, you will be prompted to “load” XYFX to the program. Tap Insert
XYFX to do this.

Tap Setup to show the Setup panel, which controls how the XY pad behaves.

Double-tap the Preset field, and tap an effect to select it. (These are just the effects available in XYFX Mode, not
all MPC effects.) Swipe up or down to view the entire list.

Tap and drag any of the knobs (Attack, Release, or Wet/Dry) up or down to set their values as desired. Below
them, you can see what parameter the X axis and Y axis control.

Note: XYFX uses an envelope to control how quickly the effect crossfades between the dry signal and wet signal.
The Attack knob determines how long it takes the completely dry signal to reach the wet signal (determined by
the Wet/Dry knob) after you touch the XY pad. The Release knob determines how long it takes the wet signal
(determined by the Wet/Dry knob) to return to the completely dry signal after you touch the XY pad.

Tap the automation button or press Read/Write (MPC X) to cycle through the available automation modes.
Make sure the button is red (the Write (W) option).

Press Play Start to start recording.

As you record, move your finger over the XY pad on the screen. The changes in the sound are being recorded as
automation of both the X axis and Y axis parameters.

Tip: While touching the XY pad, tap Latch in the lower-left corner to keep the marker on the XY pad even after
you release it. The marker will remain there until you touch another part of the XY pad or until you tap Latch again.

When you are done recording, press Stop.

Tap the automation button or press Read/Write (MPC X) to select the green Read (R) option. This ensures
your track uses the automation you just recorded when you play it back.

See Operation > Modes > XYFX Mode to learn more about using this feature.
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Using MPC X, MPC Live or MPC One as a Controller

If you are using the MPC software on your computer, you can switch MPC X, MPC Live, MPC Live Il or MPC One
into Controller Mode, allowing you to use it to control the software. MPC Studio and MPC Touch already operate as

a controller only.

The MPC software offers the same features and functionality as the MPC hardware in Standalone Mode but with some
notable differences, which are discussed in Operation > General Features > Standalone vs. Controller Mode.
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This chapter explains the complete features and functions of your MPC hardware.

Important:

When accessing the secondary functions of buttons on your MPC hardware, you can do this one of
two ways: (1) pressing and holding Shift and then pressing the desired button or (2) double-pressing
the desired button. This manual describes these operations using only the first option, but both are
acceptable.

When the left-most button at the bottom of the screen shows an upward arrow (#), it means there are
additional buttons you can use when you press and hold Shift. Press and hold Shift to show the
secondary buttons, and any of them, if desired. Release Shift to return to the previous buttons.

Almost every mode shown on the screen has 1-6 buttons at the bottom. Each of these buttons select
a different tab in that mode or perform a specific function in that mode.

MPC X: You can press the F-Key button to activate or deactivate the F-Key feature. When active, the
six buttons under the touchscreen correspond to the options shown at its bottom edge. The F-Key
button and those six buttons will be lit red when active. When inactive, the six buttons under the
touchscreen will access their normal modes instead (Menu, Browser, Step Seq, Sampler, XYFX,
and Looper).

MPC X: As an alternative to tapping a control on the screen to select it, you can use the cursors to
navigate through the controls on the screen. The center cursor acts as an Enter key.

MPC Live, MPC Live Il, MPC One, MPC Touch: As an alternative to double-tapping an item on the
screen to “enter” it, you can press the data dial.

When a parameter is highlighted and has a red outline, this means that it is selected. You can then
change it by turning the hardware’s data dial or using the -/+ buttons. If the parameter is a number,
double-tap it to show a numeric keypad on the screen to enter a specific value, or use the numeric
keypad (MPC X).

MPC Live, MPC Live Il, MPC One, MPC Touch: When the touchscreen shows a parameter or group
of parameters with a gold outline (and sometimes a Q in the corner), this means that the current bank
of Q-Link knobs will control those parameters or settings. Turn a Q-Link knob to adjust its
corresponding parameter value or setting in that group. When the value has decimal places, you can
sometimes press and hold Shift and then turn the Q-Link knob to adjust the value by smaller
increments. You can also press the Q-Link button to select another group of four parameters.

Press and hold the any of the Q-Link buttons (Project, Program, Pad Scene, Pad Param, or Screen
Control/Edit: MPC X) or the Q-Link button (MPC Live, MPC Live Il, MPC One, MPC Touch) to see an
overview of all 16 Q-Link knobs and their parameters in the QLinks window that appears. You can then
tap a column or row of knobs to select those four Q-Link knobs, and then release the Q-Link button.
See Modes > Q-Link Edit Mode to learn more about using the Q-Link knobs throughout your project.

MPC Studio IlI: This hardware functions as a controller for the MPC software. The controls are designed
to give you quick access to important software functions such as: track/program/sequence select, track
type, file browsing, sample editing, project parameters (Quantize, Timing Correct, Automation
Read/Write) and more. As such, descriptions in this manual for touchscreen operation do not apply to
MPC Studio. For more information on using the MPC software, consult the MPC Software User Guide
by going to Help > MPC Help > MPC Software Manual.
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General Features

Control Types

The MPC touchscreen uses the following types of control elements:

Knobs
To set the value for a knob, do any of the following:
e Tap and drag the knob up or down.

e Tap the knob to select it, and then use the data dial or —/+
buttons to adjust the value.

e Double-tap the knob to show it in a larger screen. Alternatively,
press the data dial, or the center cursor or Enter (MPC X),
when the knob is selected.

Tap and drag the larger version that appears, or use the data dial
or —=/+ buttons to adjust the value.

If the knob is bipolar (has positive and negative values with the
center as the default position), double-tap the larger version to
reset it to the center/0 position.

Tap anywhere else to return to the previous screen.

e Press and hold Shift while turning the data dial to adjust a value
by smaller increments.

Parameter Values

To set the value for a parameter, do either of the following:

FILTER
ENVELOPE

o Tap the field to select it, and then use the data dial or —/+ buttons
to adjust the value.

When the value has decimal places, you can sometimes press and e
hold Shift and then use the data dial or —/+ buttons to adjust the
value by smaller increments.

e Double-tap the field or hold your finger on it for a second. In the
screen that appears, use the numeric keypad, the data dial, or
the —/+ buttons to adjust the value. Alternatively, tap and drag
the value up or down.

You can also tap /2 to halve the value or x2 to double it.
To confirm the value and remain on this screen, tap Apply.
To confirm the value and return to the previous screen, tap Do It.

To return to the previous screen without changing anything,
tap t